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HRD Software LLC / HRD QUICK START

Introduction
Overview

All developers of software, have a very important saying prior to starting to
install and use the software. "RTFM"....... which stands for Read The Fine
Manual!!

Reading your manuals and following the instructions can not only get your software up
and running more quickly, it can also help prevent "pre-mature baldness” from all the
hair pulling you might do while trying to get things all put together and operating
without any guidance at all.

Experience has proven that hams WILL NOT take the time to read a manual of any
type. Insome cases this is fine. With HRD it's almost a MANDATORY task because of
the complexity of the software and all the different configuration differences.

The purpose of this guide is to provide documentation on topics required to get HRD
installed and running as painlessly as possible. This is certainly NOT a complete guide
and does NOT cover all the functionality of our software however it will help you install
the software, connect it to your radio and get you started using the basic functions of the
software.

We are in the process of updating the full HRD manual. This abbreviated, or Quick
Start manual, is provided with documentation for areas that MUST be configured
properly to allow the individual modules included in the Ham Radio Deluxe software
package to communicate with each other and interface with your radio. Instructions
are included for the Activation and configuration of the main Rig Control Module. Also
included are main options that MUST be configured in the Logbook, and Digital Master
to allow the use of the Logbook to log contacts and allow you to start working digital
modes with the Digital Master 780 module.

What You Need To Know

Your Computer

Ham Radio Deluxe is a complex software package which has a somewhat steep learning
curve. Before tackling the HRD software it is important that you have, at the very least,
a basic understanding of your computer and it's operating system. Each computer and
operating system, along with other software you have running on your computer, can
present obstacles which can affect the proper operation of the HRD software. If you
happen to need support from our technical staff, you may be asked questions about your
computer, operating system and/or other software running on your computer. Your
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knowledge of these things can save hours in troubleshooting and assisting you in getting
your HRD software working properly.

Your Radio

Having a full understanding of the operation of your particular radio isa MUST. You
must understand and know how to operate the functions from the front panel of the
radio. If your radio has an internal menu system, you need to know how to access these
menus and change the settings, if necessary.

Your radio's manual will also tell you exactly what is needed in order to connect your
radio to the computer for CAT control. It will indicate what cables you need. It will tell
you whether you need additional software drivers installed in order to access the CAT
functions or possibly internal audio capabilities for Digital modes.

In summary, your radio's manual is a VERY IMPORTANT tool when you are installing
HRD and setting it up for your particular radio. If you don't have a manual for your
radio, you can normally download a PDF copy of the user's manual from the radio
manufacturer's website.

Your Hardware Interfaces

If you are using a hardware interface, such as the Yaesu SCU-17, SignaLink USB, Rig
Blaster, Rig Expert, or any one of many hardware interfaces that allow you to connect
your radio to the computer, you need to be sure you have ALL of the proper cables,
plugs, adapters, drivers and above all documentation for the interface. You need to
read the documentation and understand how to install the device and in some cases,
know the limitations of the device you have.

Getting Technical Support

Our Technical Support Staff is always ready, willing and able to assist you with any
problems you run into with the HRD software. Note that we are responsible for the
HRD SOFTWARE Only!!

Our technicians ARE NOT teachers. They are not there to teach you to use your
radio. They do not teach you to use your interface, your computer or any other
hardware in your shack. If you contact our support team with a problem and it's
determined the issue is NOT with the HRD software, you will be advised on the next
step you should take to get help.

We do ask that you at least make an attempt with using the "Self-Help" systems we have
available for all registered and trial HRD users. We have the Knowledge Database in
our support ticket system which can answer many of the commonly asked questions
without having to directly contact a technician. To access the Knowledge Base, you can
open the main HRD website page and click on the "Help (FAQ)" option at the very top of
the page, or, you can use the link listed below in the "HRD Help Links". Other self-help
options are the HRD Forums and the HRD Channel on YouTube.
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If you are unable to find the answer to your question through the above options, then
feel free to call or open a "Support Ticket" and one of our technicians will be more than
happy to assist you.

DO NOT E-MAIL THE SALES DEPARTMENT WITH SUPPORT ISSUES. OUR
SALES STAFF CANNOT PROVIDE HELP WITH TECHNICAL ISSUES.

For those using the 30-Day Trial version, we remind you that you do have the full
support of our highly qualified Technical Support Staff should you run into any
problems installing or configuring the HRD software. If you do have any technical
problems while installing or configuring HRD, please, DO NOT CONTACT THE SALES
DEPARTMENT. They will NOT be able to help you. Please contact the support
department directly either by phone or by entering a support ticket from the "Support"
page on our website at www.hrdsoftwarellc.com or www.ham-radio-deluxe.com. The
support phone numbers and other helpful links are as follows.

HRD Help Links

Download Current version: http://www.hrdsoftwarellc.com/setup.exe
HRD V6.2 Manual: http://www.hrdsoftwarellc.com/manual.pdf

HRD Knowledge base: http://tickets.hrdsoftwarellc.com/kb/index.php
Website: http://www.hrdsoftwarellc.com

Support: http://tickets.hrdsoftwarellc.com

Forums: http://forums.hrdsoftwarellc.com

YouTube Channel: http://www.youtube.com/hrdsoftware

Support Hours: Monday - Friday 6am to 5pm EST.
Phone USA: 813-434-4650
UK/Europe: +44-1924-601057

This document is by no means a substitute for the HRD Software
manual. Even the older, outdated manuals contain basic
information about operation and functionality within the HRD
software, so, be sure to download and keep a copy of the HRD
Software manual handy for reference.
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Activation

Activating HRD

There are two types of activation involved with the Ham Radio Deluxe software. Firstis
the Trial Activation. This activation allows you to install HRD on ONE computer and
use the software for a 30 day evaluation period. The software is not crippled in any way
and the trial gives you the opportunity to check out all the features of the software.

The second type of activation comes AFTER the trial period, if you choose to keep the
software. This activation requires you to purchase an Activation Key, which when
installed in the Trial version removes the 30-day limitation and activates your perpetual
license for the software.

Since the software is registered to the owner's callsign, and NOT a specific computer, the
Activation of the HRD software also creates the "HOME" profile for the registered
callsign in the "My Station" page in the Logbook. The "My Station" profile is a GLOBAL
profile file that provides station information used by all modules in the HRD suite of
programs. The "My Station"” page will be discussed in the Logbook manual.

Trial Activation

HRD Software LLC insists you take full advantage of this 30-day trial. During the trial
period, you receive FULL support from our Technical Support staff in the event you run
into any problems with the software. Support can be received by contacting us by
phone or by entering a support ticket. (See HRD Help Links in the Introduction
chapter of this manual)

In order to activate the full 30-day trial version you need an active internet
connection. If you do not have an active internet connection, the trial version is
limited to only 7 days.

Full Activation

Full activation of the HRD software requires you to purchase an activation key on-line
by going to our website at www.hrdsoftwarellc.com and selecting “Purchases” from the
top menu or by going to the following link: http://www.hrdsoftwarellc.com/cgi-
bin/store/commerce.cgi?pid=1

This activation key, when installed in the Trial version of HRD, removes the 30-day
limitation and the License Manager "Nag Screen" that pops up when each module of the
Trial version is loaded. It also gives you 1 full year of PAID technical support from our
support staff and access to all new features included in the HRD software versions

®)


http://www.hrdsoftwarellc.com/
http://www.hrdsoftwarellc.com/cgi-bin/store/commerce.cgi?pid=1
http://www.hrdsoftwarellc.com/cgi-bin/store/commerce.cgi?pid=1

HRD Software LLC / HRD QUICK START

released during that year.

The activation key actually has TWO purposes. The first is removing the 30-day
limitation from the Trial version of HRD. Once activated, the HRD software will run
"FOREVER" or as long as you want to use it. The software NEVER expires, however, as
mentioned above, when you first activate HRD, you receive ONE FULL YEAR of PAID
technical support and any NEW FEATURES added to HRD during that year will be
UNLOCKED.

After the first year, this is where the SECOND purpose of the activation key comes into

play. This is our way of tracking your PAID Support and Software Maintenance
Agreement.

<=-License Manager

Ham Radic Deluxe g~ g,
!-iotf?se Manager g’? Clicking on "Help" and selecting "HRD
Thie Suparont icenes by cplret License Manager" In any one of the HRD
SN CooMcC s it I program modules yvll_l display the HRD
License Manager similar to the one on the left.

| MAt the end of your first year, your License
Manager will display similar to the image on
the left. Notice the License Key (XX1XXX)
appears in "RED" and the text inside the red
box states "The Support License has expired".

Expires: 1212014

This does NOT mean the software is going to stop working. It means that you no
longer have access to the HRD Paid support and from the expiration date forward, when
you download a new release of HRD, any new features added to the software AFTER the
expiration date will be LOCKED. You will still have full access to all features of your
software up to the expiration date and it will run normally for you, but, installing any
releases AFTER the expiration date, you will only receive the benefit of any BUG FIXES
done in the software.

So, what does this mean?

HRD Software LLC provides a non-mandatory Software Support and Maintenance
Agreement. This is provided through an annual renewal fee of 1/2 (50%) of the retail
cost of the HRD software. When purchased on an annual basis, this provides you with
another year of PAID technical support from our staff along with ensuring you not only
receive all the up-to-date bug fixes, but also unlocks any and all new features added to
the Ham Radio Deluxe software.

The nice thing about this option is the fact it is non-mandatory, and, if you choose, you
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don't even have to renew every year. If your software is running fine and doing all the
things you want it to do at the end of your first year, you may choose not to renew. You
can still download each and every release to receive any bug fixes.

Now, let’s say a couple years have passed and we are adding a new feature that "YOU
JUST CAN'T LIVE WITHOUT...". At that time, you can just renew your Support and
Maintenance Agreement for 1/2 (50%) of the retail cost of the software and receive
another full year of PAID support along with unlocking the new features of HRD.

Upon starting HRD you will see the following screens.

Ham Radic Deluxe =4
Welcome to Ham Radio Deluxe! <-- Welcome Screen

Since this is your first time using HRD, & temporary icense needs to be obtained for your calkig

Your callsign will be needed.

s If you are installing HRD's trial version, you will first se
fleft. Click on the [Next] button to continue.

(wext= | [ cancal |
Fo Ratfi Dol <-- Cal |Sign
If you are a licensed amateur radio operator, your
S e e e callsign must be entered in this location. Click [Next]

Callsign: | KB3WPH

NOTE: If you are an SWL or do not currently have your
e o i ham radio license, you can use any group of 3 or 4
letters and a single number from O to 9, such as ABC1,
ws Jme ] [ | [TABE4, GABE2 or something similar. Just make sure
the group you choose DOES NOT in any way resemble
any amateur radio callsign.

Ham Radio Deluxe == .<“ ACtiVati on Key

e st et vt v oo e vmrsas. - JOINICE WE @re activating the Trial version of HRD, you
et s, o masmresnza v, QW NOT have an Activation Key, so, do not enter
T ——— anything in this screen. Just click the [Next]
fbutton to continue with the activation of the
Trial version.

Click on [Next] when finished.

[ <Back ex Cancel

Entering Your Activation Key
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When you make your purchase of your HRD Activation Key, you will immediately
receive the key on a page at the end of the purchase process. If you don't see your key,
don't panic. Just complete your purchase and once completed, please send an e-mail to
our sales department (sales@hrdsoftwarellc.com) and they will be more than happy to
e-mail your key to you.

Once you have your Activation Key, proceed by starting HRD. On the main menu of
any of the HRD program modules, click the "TOOLS" option then select the "HRD
License Manager" from the dropdown menu. When the License Manager opens,
proceed as instructed below.

,},,mmm;—é- e Lo ] s e Y {w<__ License Manager

o harve B P grester Fan four sectons, please contsct HAD sapport.

" ase o
Tytat yeur coliscn. Pioseed
0 NOT s ssthas]

Cadegn:
Type the ey Fatis found on the s3cker nsde your OO case.
For Diem Made or f you are 8 regstered HAD user, leave the acthl

Actation K . . . }
Canenl

i /o 5
Vi | "oy
semane :
Continue: Ext HeD

If you have any issues entering your Activation Key, please see the Troubleshooting
suggestions at the end of this chapter.

81. Click "Activate"

§2. The "Add New License" window will open
83. Enter your Callsign

4. Type or copy and paste your Activation Key
5. Click "OK" to return to the License Manager
6. Click "Continue"

Once you click the "Continue" you will be presented
with the Rig Connect Configuration screen.

Entering Additional Keys

Many hams, for whatever reason, have more than one callsign. HRD Software LLC has
provisions for this situation.

An additional activation key is required for EACH callsign you wish to use in
HRD. These keys are provided at NO COST.

To receive an additional key, you need to send an e-mail to our sales department

at sales@hrdsoftwarellc.com. In the e-mail, include your HRD Registered callsign along
with any additional calls you need keys for. Once our staff has verified the callsign
belongs to you, a key will be sent via return e-mail.

If you are requesting a key for a Club callsign for a license already owned by that club,
we must be able to verify that you are a trustee for the club. Club members, alone, can
not be provided with keys for their club callsigns.

To enter any additional keys into the HRD software, follow the same procedure as
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outlined in the section for Full Activation.

Connecting Your Equipment

Testing the HRD Software

We now have Ham Radio Deluxe installed and our radio ready to be connected, lets test
the HRD software to make sure it is installed and operating properly. This is done
using one of the built-in Dem-o-matic radios.

The Dem-o-matic radio is ideal for testing the software installation or demonstrating
Ham Radio Deluxe without having to have an actual radio connected. Running HRD
with one of the Dem-o-matic radios before actually connecting your radio equipment,
you get the opportunity to make sure your installation went well and the HRD software
is loading and operating as it should.

Run the Ham Radio Deluxe software by double-left clicking on the HRD Desktop icon.
Once the splash screen has closed you see the Connect window. If you do not have the
correct connection cable for your particular radio, select one of the Dem-o-matic
radios so that you can open Ham Radio Deluxe.

& Connect: KB3NPH in United States Fa<--Dem-o-matic

;The Dem-o0-matic radios do not need

New | Pt | Sesbesis | fietn cables — simply select Dem-o-matic in
S — f[he Compqny drop down, select an option
T in the Radio drop down, and then press

Orion: Demo
K2 Demo
T5-480: Demo
T5-570: Dema
T5-690: Demo
T5-2000: Demo
FT-450: Demo
950 O

FT-2000: Demo

Connect. This will then open the main
Rig Control screen giving you access to the
simulated HF radio chosen from the Radio
dropdown menu in the configuration
window.

Once you have selected the Dem-o-Matic radio as shown above, click on the "Connect”
button to actually connect to the radio and bring up the Rig Control screen.
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Fle Edt View Bands Favorites OuickSave Macos  Logl Radio Options  Scanning Tuning Tools Voice DStar Window p -8%

Hel
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@ € H P - i ﬁ 7 Q== X
Connect Selection Favoete Quack Save | Satellites L DMTED Rotater L Full Screen 5W Data | Sheen | Customie Opbcns Foums g

2 FT-950: Dema
E
£

4 000

[Tk [Tse] it [8020) [omo] [ 00| [Faow| (50w [Smv] [F0m0) [0

From the Rig Control screen, you can now start and test the other four modules of HRD
by clicking on the individual icons shown in the "red box" on the Icon Toolbar.

The Dem-o-matic radio feature in HRD can also be valuable as a diagnostic tool. If you
are having issues with HRD, you can run one of the Dem-o-matic radios to check if the
issue you are having is related directly to the software or if it is between the interface
and your own radio. If you run in the Dem-o-matic mode and the issue you are seeing
disappears, you know the software is functioning as it should and the problem you are
seeing is either related to the interface your using, such as the Com port drivers, cables
or other hardware connected between the computer and the radio, or, possibly an issue
with the radio itself.

Rig Connect Screen

Once HRD has been activated the next screen you will see is the Rig Connection screen.
Here is where you configure Ham Radio Deluxe to connect to the particular radio you
are using.

We'll begin this section with an explanation of the Rig Connect screen.

The Rig Connect screen has 4 tabs across the top. Each tab contains specific
information which helps HRD connect to your radio.
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D < T New Tab

New Preset
v
FT-950: Demo -

Serial Ports Help

Company: Status

Radio:

[ Always connect to this radio when
starting HRD Rig Control.
Auto Exit

v HRD Digital Master
¥ HRD Logbook
¥ Entire HRD Suite

n Connect

Start HRD Rig Control in
Full Screen mode

Auto Start
[~ HRD Digital Master

[~ HRD Logbook
™ HRD Raotator
[ HRD Satelite Track

The "New" tab is used to configure HRD to
connect to a new radio being added to the
system. Here is where you select the radio
Manufacturer and radio model. We also
configure the Com port and port speed used
by the Rig Control software in HRD to
connect to the CAT firmware in the radio.

Other items that are configured on this tab
are the CI-V address used by Icom radios and
the Flow Control settings (CTS, DTR and
RTS lines).

Note: Most Yaesu and Icom radios require
only the RTS item to be checked while
Kenwood requires the RTS and CTS to be
checked.

You will also notice other check boxes for additional options on the lower portion of the
Rig Connect screen. When setting up HRD for the FIRST time, it is recommended you

DO NOT check any of these boxes.
is to connect to the radio and start the main HRD software.

The first and most important operation at this point

We will explain how to set

these other options once we get the radio connected and the HRD Rig Control module

running.

New Preset Serial Ports Help

Company Radio Port
Yaesu FT-857D com7
Yaesu FT-857D Remote
Yaesu FT-950 comz2
@ Dem-o-Matic® FT-950:Demo  None
Yaesu FTDX-1200 comz

®Dem-o-Matic® TS-2000: Demo None

<

X Bemove

Connect

I~ Always connect to this radio when
starting HRD Rig Control.
Auto Exit

r Start HRD Rig Control in

5 e
S W HRD Digital Master

¥ HRD Loghook
¥ Entire HRD Suite

Speed

CI-V Addres
4.800 -
4,300
4,300

0
4,80

=<1

Auto Start
[~ HRD Digital Master

[~ HRD Logbook
™ HRD Rotator
[ HRD Satelite Track

<--The Preset Tab

Upon first starting the HRD software, the
"Preset" tab is empty. Once you have
successfully configured and connected to your
radio from the "New" tab, an entry will
automatically be added to this tab with the
information about your connection. This
serves TWO purposes. First, it gives you a
record of the configuration used to connect to
your radio and the second is, if you have more
than ONE radio connected to your computer
and HRD, this is where you can select which
radio or radios you want to connect during an
operating session.
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Once you have your radio or radios configured and connected to HRD we HIGHLY
RECOMMEND you take a screenshot of this screen and keep it in a safe place. This will
come in handy if for some reason you need to re-configure a radio connection for any
reason you have the actual settings used, so there's no guessing or searching for the
settings needed.

When you have a radio or radios configured in the "Preset"” tab, to start that particular
Rig Control, just left-click on the selected radio and click the "Connect" button.

If you have a radio configured on the "PreSet Tab", which you no longer own or have

connected to Ham Radio Deluxe, you can easily remove it from the Presets by clicking
on the setup line in the display window, to highlight the unwanted configuration, and
click on the "X Remove" located on the left just below the slider near the left center of

the dialog box.
l<--Serial Ports Tab

'This tab displays the Com ports available on

New  Preset SeralPorts  Help lyour computer. It can come in handy as a
Compary: [Yaews =] | | Status quick reference when trying to find what
Radc:  [FT.8670 <l port your radio is connected to.

COM Port: |COM2 |

Just below the main window, there are two
options which can be selected. One isto
"Show ALL ports"” and the other is "Only
ports connected to PC".

Speed:

COM7
Flow cont COM8

Connact I Always connect to this radio when
starting HRD Rig Control. Auto Start
Auto Exit ™" HRD Digital Master

r Etﬁ'gHHD Fig d'iﬂnlml in [¥ HRD Digital Master ™ HRAD Logbook
ull sEreen mode ¥ HRD Logbook I~ HRD Rotator

¥ Entire HRD Suite I™ HRD Satelite Track

If you have the "Show ALL ports" ticked, if you have ever had any device connected to
this computer that required the use of a Com port, and a device driver was installed, it
will show up in this list.  If you have ports showing in this list that are no longer used or
needed, it's recommended you uninstall the ports and drivers for the particular ports.

If you tick the "Only ports connected to PC" only the currently active ports are

shown. These are ports that have devices connected to them, such as your printers,
radios, or any other device that requires connection via a Com or printer port.
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Connecting Your Hardware
Before we start this next section, PLEASE DO SOME HOMEWORK!!!

Your radio owner's manual and the Ham Radio Deluxe manual are your BEST FRIENDS
when it comes to configuring the Rig Connection.  If you don't have these manuals,
you can usually download your radio's operating manual from the manufacturer's
website in PDF format. You can also download the HRD V6.x manual from the
download page at www.hrdsoftwarellc.com.

Many of today's radios have extensive menu systems built in. During the connection
process and at other times while configuring the HRD software, you may have to refer to
locations in these menus ..to set options or make changes that effect the connectivity
and operation of your radio with the HRD software. Itis VERY IMPORTANT that you
KNOW and UNDERSTAND how to operate the menu systems in your radio. There
may be a time when you have to contact HRD Technical Support for assistance with
some issue you are having and the technician may ask you to check certain menu
options in the radio. Knowing how to do this is YOUR responsibility and not that of the
HRD technician.

Read your radio's manual to find out exactly how it is supposed to be connected to a
computer for CAT control. Some radios require special drivers to be loaded in the
computer to access certain model radios. These drivers can usually be downloaded from
the manufacturers website. All this information is in your radios user manual or from
the radio's manufacturers tech support.

Please refer to "Radio Interfacing" in the Introduction section. to review the
requirements for Ham Radio Deluxe interfacing.

To connect your radio you will need to connect the necessary cables and install drives if
needed. You must also do some configuring within Ham Radio Deluxe. This is usually a
one time exercise.

Once you have all your cables in place it's time to turn on your radio, boot up your
computer and start Ham Radio Deluxe. The next screen you should see is the radio
connection setup screen. This is where you select your radio and set some parameters to
allow the Ham Radio Deluxe Rig Control software to connect to your radio.

Connecting Flex and SDR Radios

SDR radios present an entirely different situation.  These radios require special SDR
software such as PowerSDR, SmartSDR, or other SDR software as PART of the radio's
operating system.  They also require some virtual Com port and virtual Audio Cable
software in order to connect with Ham Radio Deluxe and your SDR software. The
Flex SmartSDR software package contains everything you need as far as the virtual Com
port drivers and virtual Audio cable software. If your SDR radio requires some other
software, your radio manufacturer or the dealer where you purchased your SDR radio
should be able to help you with these items and assist you in getting your SDR up and
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running.

Once you have your SDR radio up and running, with all the required virtual Com port
drivers and Audio Cable software loaded and connected, if you have any issues
connecting with the HRD software, then, and ONLY then, the HRD Tech Support staff
can assist you.

Lets Get Connected

The following section will guide you through connecting your own radio equipment to
HRD. These instructions are rather generic, but they apply to ALL radios supported by
the HRD software. In our examples we will be connecting to a Yaesu FT-950.

Note: ICOM: disable the CI-V Transceive option for best performance.

Kenwood: make sure Packet communication mode is switched OFF (if
supported). Most Kenwood radios require CTS and RTS to be ON for flow
control.

These options are set from within the radio's menus. You can find the menu number
and directions on how to change these setting in your radio's owners manual.

{In the Rig Connection screen at the left,

New  Preset SerialPots  Help select the "Company" dropdown menu and
Conpary: [SDemoMaic® =] [ | Swms indicate the manufacturer of your radio in
T this field. In this instance, we are showing
con "Yaesu" as the manufacturer. Once you
E:Sﬁii?? have selected the manufacturer, move to the
icrotelecom =
SOR RADIO "Radio" dropdown.
en-Tec
Yaesu E
B = B
Coment | T o st
Auto Exit [™ HRD Digital Master
r Start HRD Rig Control in ¥ HRD Digital Master [~ HRD Logbook
Full Screen mode ¥ HRD Logbook ™ HRD Ratator
¥ Entire HRD Suite ™ HRD Satelite Track
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Company: |Yaesu hd Status
Radio: FT-100 -

FT-817 A
FT-817D
. |FT-840
COM Port: FT.847
X FT-857
Speed: FT 8570
FT-830 B
FT-897
FT-837D
Flovs conty FT-300
FT-920
r FT-350
FT-380 1
[ Always connect to this radio when
Connect starting HRD Rig Control.
Auto Ext
Start HRD Rig Control in ¥ HRD Digital Mast
r igital Master
Full Screen mode ¥ HRD Logbock.
[¥ Entire HRD Suite

Auta Start

™ HRD Digital Master
[~ HRD Logbook

™ HRD Rotator

™ HRD Satelite Track
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x |<——Radio

Here we select the Model of the radio we're
connecting. This selection also selects the
CAT command set used in HRD to control
the radio you select.

New Preset Serial Ports Help

Company:  |Yaesu - Status
Radio: FT-857D o
COM Port. [COM2 b
Speed:
COM7
Flow confs COME
r Auto-detect
I Always connect to this radio when
Connect starting HRD Rig Control.

Auto Exit

r Start HRD Rig Control in

¥ HRD Digital Mast
Full Screen mode sk

¥ HRD Loghook
¥ Entire HRD Suite

Auto Start
I HRD Digital Master

I” HRD Logbook
[~ HRD Rotator
[~ HRD Satellite Track

F<--COM Port

iSelect the Com port the CAT control
interface uses to communicate with the
radio’'s command set. You can select this
based on observations in the Device
Manager. If you are unable to determine
what Com port is used, you can use the
"Auto-Detect” function at the bottom of the
Com port list. If using the Auto-Detect
option, once you begin the connection
process you will see, in the "Status” window
how HRD tests each port connected to the
computer to see if it finds your radio.
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New Preset Serial Ports Help
Company: |'Yaesu - Status
Radic:  |FT-857D |
COM Port: |COM2 x:
Speed  [4300 |
4800
9600 b
Flow cont{ 35400
Auto-detect
[ OTH A
| [7 Always connect ta this radio when
n Connect starting HRD Rig Control. Auto Start

Auto Exit
[¥ HRD Digital Master
¥ HRD Logbook
|¥ Entire HRD Suite

[ HRD Digital Master
[~ HRD Logbook
[ HRD Rotator

r Start HRD Rig Control in
Full Screen mode

™ HRD Satelite Track

‘The Com port "Speed" is selected based on a
setting in the radio’'s menu system. Usually
checking the radio's manual will provide a
list of baud rates available for use on the
Com port. The speed set in the HRD
Connect dialog MUST MATCH the speed set
for the Com port baud rate in the radio's
internal menu.

Most radios provide a DEFAULT setting, for Yaesu it is normally 4800. You should
always try the connection using the default speed first. If you have difficulties
maintaining a connection then try different speeds.

If you DON'T know the default speed, here again, there is an "Auto-Detect” option which
can be used. HRD will check each port at each speed the radio is capable of handling

until it finds the correct one for connection.

New Preset Serial Ports Help
Company: |Yaesu > Status
Radio: FT-950 hd
COM Port: |COM2 hs
Speed 4800 -
Flow control / Interface power
r ™ DTR ™ RTS 4-—-9

(Bt I Always connect to this radio when

starting HRD Rig Control
w Auto Exit
r Start HRD Rig ContfTin I

Full Screen mode r

Auta Start
™ HRD Digital Master

[ HRD Logbook
™ HRD Rotator

I Entire HRD Suite [~ HRD Sateliie Track

<--Other Settings

CI-V Address

ICOM only: the address assigned to the
radio, consult the radio's documentation for
the default address. This can also be
configured via the radio's configuration
menu.

CTS
Enables the CTS flow control, required for
Kenwood radios.

DTR

Enables the DTR line when the COM Port is
opened and leaves it on, usually to provide
power for an interface cable. For Yaesu CT-
62 and ICOM CT-17 interfaces this can be
left unchecked (off).
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RTS

Enables the RTS line when the COM Port is
opened and leaves it on, usually to provide
power for an interface cable. For Yaesu CT-
62 and ICOM CT-17 inter- faces this can be
left unchecked (off).

Next, put a check in the boxes for DTR and
RTS. Some radios don't require both of
these settings checked so they can be
unchecked if there is a failure to connect to
the radio.

Once you have all the settings in the Rig Connection screen selected, click on the
"Connect"” (3) button. If all is configured properly the next screen to appear will be the
HRD Rig Control screen.

3

Fie Edt View Bands Favortes OuickSave Macos Logbock RedioOptions Scanming Tuming Tooks Voice Ditar Window Help

'S ] - e O 2 & &

@ € H a S B @ & 7 Q== X
Conaect Selection Favonte Cuck Save | Setallites Logbook DMT3) Rotator Dupley Mapper | Full Screen S0 Data || Siden | Customue OptionsForums g

2 FT-950: Dema

i

-8N

4 000

The Rig Control screen is fully customizable with many color and layout options pre-
programmed into the HRD software to chose from. You can also design your own
custom layout and color screens with the built-in editor. For more information on how
to customize the screen layout, please refer to the HRD V6.3 Users Manual.
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Rig Control

Rig Control

For the purpose of our Quick Start Guide, we are not going into any great detail of all the
features available. We will just be showing the major setup features needed for proper
operation of the radio. For complete details of all features and functions available,
please download and read the HRD V6.x User's manual. It can be downloaded in PDF
format from the Downloads page of our website or by clicking on the following URL
link: HRD V6.X Manual: http://www.hrdsoftwarellc.com/manual.pdf

From within the Rig Control Module, you can directly control all major features of your
radio, connect multiple radios to your computer, access other HRD suite modules and
much more.

Again, we remind you that this document is only going to cover a few of the main
features of HRD in order to just get you up and running. For details on other options
and features, you need to see the full HRD User's Manual.

The Rig Control Screen

Once you have successfully connected to your radio, the first screen that will appear is
the Rig Control Screen. This is a generic screen and is basically the same for all radios
regardless of the manufacturer or model. The only difference between radios are the
functions displayed on the screen. The buttons and functions on the screen are
dependent on the CAT firmware in each model radio. Different radios will display
different functions in the Rig Control screen. The screen used in this section is that
seen when connected to an Yaesu FT-950. This display is typical of what most radios
display, although some show more control buttons and sliders and some show less, but
the main layout is the same.
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14.235.000

3.780.000

There are actually TWO views available for the Rig Control screen. The first view being
as it appears above showing the Main Menu options and the Toolbar Icons. The
alternate view is shown in the next image and is considered the "FULL SCREEN" view.

By pressing the "F4" key, on your keyboard, you can toggle between the
Normal and the Full Screen view.

In the Full Screen view below, the Main Menu and the Icon Toolbar are not visible.

You will notice the icon indicated by the red box and arrow on the screen indicates you
are in Full Screen mode and reminds you to press the "F4" key to return to the alternate
view. Thisicon, if it appears on top of any major controls or buttons, can be moved out
of the way by left-clicking on the icon, holding the mouse button down while sliding the
icon to a location on the screen where it no longer is covering any controls or buttons.
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Caution: Choose Proper Region

The first and most important setting you need to make in the Rig Control screen is the
ITU Regional Band Map for your particular region. The three IARU Regions are
orgnized to broadly mirror the structure of the ITU and its related regional
telecommunications organizations. These regions are as follows:

IARU Region 1: Europe, Africa, Middle East and Northern Asia
IARU Region 2: The Americas and Canada
IARU Region 3: Asia - Pacific

These Regions usually have different frequency allocations for each amateur radio band,
so, selecting the WRONG region frequency bandmap when setting up HRD could result
in the possibility of you operating on a restricted or out of band frequency. Please be
sure you select the proper bandmap for your region before continuing to use HRD.

_Selecting The IRAU Region

HRD comes pre-configured with several bandmaps installed. These are contain default
settings and frequency ranges to be used to help you design custom bandmaps should
you choose to do so. The regional bandmaps contain the frequency ranges allocated for
the Amateur Radio HF bands from 160 to 10 meters for that particular region. Be sure
to select the region that you live in so as not to create problems for yourself later on.
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In the center of the Rig
Control screen, below
— N e frequency displays
Bands B\ OU see the bandmap
160m - 10m (Region 1) which is selected.
et ll g i91t-click on the
e : = madisplay to shovy the
160m - 70cm (General) ~ bandmaps available.
60m (5 MHz) lllSelect the bandplan

6m (Detail) that pertains to your
rmccast region. This bandplan
ol Rwill be loaded and you
VHE - UHF T ———\i|| be set to operate
using the allocated
frequencies for your
|region.

3.780.000

160m - ?ch

Manager
Close

You notice there are several selections in this menu. These selections show you how to
create custom bandplans of your own. There are more details on creating custom
bandmaps in the HRD User's manual.

Accessing Other HRD Modules

There are two ways of accessing the other modules in the HRD suite. You can open
them manually by clicking on their icons on the Rig Control Toolbar, or, you can have
them automatically start when you run the software. As recommended earlier in this
documentation, you should have ONLY the Rig Control Module loaded at this time.
Again, this recommendation was made just to ensure the software connected properly to
your radio and help speed up troubleshooting should you have an issue without having
to walit till the other modules automatically load, then close them to start over if
necessary.

The Toolbar

With the Rig Control display set to show the Main Menu and Toolbar, you will see Icons
which allow you to manually start any or all of the other modules contained in the HRD
suite. We would like to remind you that the more modules and options you have open,
more MEMORY is used not only to run the module in but also to store data collected
and displayed by the particular module. We recommend you open ONLY the modules
you are using during each session. For example, if you do not have an antenna rotator,
and you just plan to make and log only VOICE contacts during a session, you will only
need the Rig Control and the Logbook modules open. If you plan on working Digital
Modes during a session, then of course, you will need Rig Control, Logbook and DM-
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780 open. Just remember also that DM-780 requires even more resources (Memory)
than any other module because of the decoding of the digital signals. Even more is
needed if you use the SuperSweeper option in DM-780.

b= HRD Rig Control - [FT-857D]

O @ Hl|= g © KlE @ = (B L& 0
Connect Selection Favorite Quick Save | Satellites Logbook DM780 Rotator Display Mapper | Full Screen SW Data || Sliders  Customize Options Forums .

The Icons indicated above, and located on the HRD Rig Control Toolbar, are used
to manually activate that particular module in HRD.

Activates the Satellite Tracker

Activates the Logbook

Activates Digital Master 780

Activates the Rotator Control Interface

Activates "Mapper", which is a special option that allows you to track your Logbook
contacts on a World Map.

aglrowpE

Auto-Start - Auto Exit

If you use one radio as a default, and/or if you consistently use certain modules every
session, you can have them Auto-Start when you activate HRD from your desktop Icon.
To do this, click on the "Connect" Icon which is the green circle with the white arrow
located on the left end of the Toolbar.

This icon opens the "Rig Connection” screen where you can configure which
modules you would like to have Auto-Start when you start the HRD software.
You could also bring up the Rig Connection screen by clicking on "FILE" then
select "CONNECT".

Connect
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Select Default Radio

@ Connect: KBINPH in United States JMAfter the first time connection to your radio,
an entry will be automatically created in the
"Preset" tab indicating the connection

New Preset  SerialPorts  Help parameters for that particular radio. After
Company Radio Fon | speed| cvaddes  the initial connection, you can select any of
b Ak e the radios connected to HRD as the "Default”
aesu FT-857D Remote 4,800 - ) B
Yaesu FT-950 COMZ 4800 - radio to use when starting the HRD software.
®Dem-o-Matic® FT-950: Demo  None 0 -
Yaesu ) FTDX-1200 comz 4,800
Bl ol ¢ Left-click on the radio you would like to have
as default to highlight it's entry. Place a
< > check mark in the box indicating "Always
X Remove connect to this radio when starting HRD Rig
ways connect to this radio when Controrl
Comect | ¥ e D Big Cor R
TR C I~ HRD Digital Master . .
- SatHRD Rigontiolin | [~ HRD DighalMaster || [~ HRD Logbook When you click the HRD Desktop icon, HRD
™ HRD Logbook [~ HRD Rotator - H i 1 i
™ Eniie HRD Suite - i s | Wil NOW automatically start with this radio
connected.

Auto-Start HRD Modules

© Connect: KBINPH in United States = Placing check marks in the boxes indicated
within the "RED" square in the image to the
left will cause that module to automatically

New Preset  SerialPorts  Help start along with the Rig Control screen when
Company Radio Port | Speed| CIVAddress yOU start HRD from yOLII’ dESktop iCOﬂ. The
Yaesu FT-857D comz7 4.800 - - i

e e A ‘ '(I)nly mod"ule you can not auto-start is the
©Dem-oMatic® FT-950 Demo  None o - Mapper", which is normally only used
@Dem-o-Matic® TS-2000: Demo  None 0 -

occasionally and is normally not used during
an actual operating session.

< >

X Remove

Connect I Abways connect to this radio when

starting HRD Rig Control. Boto oran
Auto Exit Iv HRD Digital Master
1~ Start HRD Rig Control in r M ¥ HRD Logbook
Full 5 )
el e r ™ HRD Rotator
I Entire HAD Suie I~ HRD Satelite Track
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Auto-Exit HRD Software

[ © comect Ke3neH in United States < A new feature to the HRD software is the
Auto-Exit feature. Checking the Auto-Exit
boxes as indicated on the left, allows you to

New Preset  SeralPorts  Help click on the [X] in the upper right corner of
Company Radio Pot | speed] civaddes  the Rig Control screen and all open modules
Yaesu FT-857D com7 4,800 - 1 1 1 1 1

e e E—— , will close automatically. This eliminates the
Yaesu FT-950 COM2 4800 - need to close each module separately.
@Dem-o-Matic® FT-950:Demo  None 0 -

Yaesu FTDX-1200 com2 4800

®Dem-o-Matic® TS-2000: Demo Nane 0

< % >

X Remove

Connact 2 .jfl::gys connect to this radio when

| Auto Start
v HAD Digital Master

¥ HRAD Logbook

™ HRD Rotator
¥ Entire HRD Suite I~ HRD Satelite Track

r Start HRD Rig Control in
Full Screen mode

There is ONE drawback to using this feature. You should ALWAYS do a manual
backup of your Logbook prior to using this method of shutting down HRD. This
method uses the Windows "Kill Process" function which bypasses the normal shutdown
procedures and the Logbook module will NOT create a backup if you have that selected
as one of the automatic backup methods in the Logbook module.
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Logbook

LoTW and eOSL Membership List

When starting HRD and the Logbook each day, you will see the following screens when
the Logbook starts.

i HRD Scheduler - LOTW Membership X| i HRD Scheduler - eQSL Membership X
0 The LOTW Membership list is due for an update. The eQSL Membership list is due for an update.
What do you want to do? What do you want to do?
—» Download - Download
This will download the membership list as scheduled. This will download the membership list as scheduled.
—» Download and Hide —> Download and Hide
This will always download the membership list and never show this window This will always download the membership list and never show this window
again. again.
—» Nothing — Nothing
This will cancel the download until the next start of HRD Loghook. This will cancel the download until the next start of HRD Logboak.
—> Nothing and Cancel - Nothing and Cancel
This will cancel the download forever. This will cancel the download forever.
Cancel Cancel

These screens are for downloading a text file which contains a list of members of LoTW
and eQSL. This option is associated directly with the DX Cluster feature in HRD.
There are columns in the DX cluster marked "L" and "E".

When a spot appears in the list, HRD checks these listings and places a check mark in
the appropriate column if the spotted contact is a member of LOTW or eQSL. This will
indicate to you, at a glance, how to QSL this contact.

The option can be controlled from the Options menu on the DX Cluster toolbar. You
can set this option to be performed in the background where you will not be notified
when it is done, or, you can have it not do the download at all.

My Station Data

There is one area in the Logbook that MUST be configured in order for other modules in
HRD to function properly. This is the "My Station" configuration. The data in this
dialog is stored in the Windows Registry file and is used in the Logbook, DX Cluster,
DM-780, Rotator and Satellite Tracking modules of HRD.

It is also used to locate your station on the Goggle Map, if used along with the HRD
software.
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Open the Logbook module. On the Main Menu, click on "Tools > Configure > My
Station". This opens the "My Station" dialog as shown below.

el BVl L. o

R - You will see in the dialog, there are TWO

gt e ~_ tabs automatically created. One tab
= contains your callsign. This tab is created
and reflects the "HOME" location for the
registered owner's callsign. The "GUEST"
R tab is a profile which can be created for
temporary use. The data for this tab is
) NOT saved between sessions and must be
re-entered each time HRD is re-started.

Sauat

All items indicated in the image above should be filled in. The most important items
are inside the "red" box. These items are your Grid Locator and the Latitude and
Longitude. These items are used for placing your HOME location on the Google Earth
map, if being used, and for the home location in the Rotator and Satellite Tracking
software.

Your Grid Square must be filled in, and if you don't know it, you can obtain it by looking
up your call in the QRZ Callsign lookup database. Once you have inserted your Grid
Locator, clicking on the downward pointing arrow (indicated by the red arrow above)
will automatically fill in your Latitude and Longitude fields.

Once all information is completed in this dialog box, clicking on the [ X ] in the upper
right corner will save the data and exit the page.

Callsign Lookups

The Callsign Lookup feature in HRD is extremely useful, however it is very and is
structured to work in a specific way. HRD provides for many sources for callsign
lookups, including web based lookups, CDs and local Databases, Country Listings and
Unique Callsign Databases. In order for the Lookup feature to function properly, these
sources must be configured in a specific way within the HRD Lookup structure.

When first installing HRD, if you open your Logbook screen and on the top menu click
on "TOOLS" then "Configure” then select "Callsign Lookup", you will see the lookup
options as shown below.
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p—— N
. The options listed in the window on the left
are the "ENABLED" lookup methods, and

_ those listed in the window on the right are
"DISABLED" lookup methods. The
current view in the image on the left is the
default settings for the callsign lookups.
Only the Logbook and the Country List are

. used when these options are set.

Ena abled Methods:

Logbook QRZ.com Subscription

Prevens kaghas 0508 . et babed XML o on OAT tom

Country List 8- QRZCD .
HamCall CD

With the default setting above, when a callsign is added to the "ALE" (Add Log Entry)
screen, and you click the "TAB" key your keyboard, HRD will first look in the current
Logbook Database and all configured logbook databases, to see if it can find where you
had previously worked that callsign. If found in any of your configured databases, the
information from the "LAST QSO" with that station will populate the fields in the ALE.
When saved, this data will be saved in the current contact record for that call.

Be Aware: Contact and location information can change from time to time
for a given call, especially for DX and Special Event Calls.

Again, with the default settings shown above, if a call IS NOT found in any of your
logbook databases, HRD then looks to the Country List and the Unique Call Sign
Database and populates the ALE with ONLY the country associated with that call.

HRD provides direct access to 6 different Callsign Lookup sources. The QRZ.com
Subscription is, by far, the best source since is it always up to date, as is the the
HamCall.net Subscription. Both are on-line services, requiring an internet connection
and are updated with new callsigns almost daily, however, both require an annual fee, or
subscription charge, to access their lookup service.

Next would be the CDs, however, these options really do become outdated very quickly
and do not contain the most recent callsigns. CD Lookup sources can be used when you
are operating where you do not have an internet connection to access the on-line
sources.

Callook.info is a FREE online service, however, it has one drawback. It contains ONLY
United States callsigns, same as the SAM CD. If you're interested in automatic logging of
only U.S. callsigns, these are a good choice.

To add functionality to the HRD Callsign Lookup, we can add any one or more of the
additional lookup sources from the DISABLED methods to the ENABLED methods.
This is simply done by highlighting the method in the right window by left-clicking on it,
then clicking on the [ <] button located between the two windows. This moves the
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method from the disabled window to the enabled window as shown below.

Callign Lockup x
Enable | Lox

Notice we have moved the QRZ.com
Subscription to the enabled methods.
Notice also we have arranged the lookup
order so that the QRZ.com lookup is
SECOND in the lookup sequence.

Country List -

ﬂ;omm The position of a particular lookup option
in the enabled side of the above screen can
be easily adjusted by using the [+ ] and [ -
] buttons to the right of the option. Clicking
the [ + } moves the option up in the list
] [ while clicking the [ - ] moves the option
down.

The position of the enabled lookup options is very important, and can be most
commonly related to the ability to show the "Worked Status" of contacts in DM-780
when you hover over their callsign in the Receive Pane. In this instance, having the
Logbook as the first option gives us the ability to see if we have worked this station
previously, and accurately, since the Logbook is the FIRST place HRD checks for the
callsign lookup information.

If, for example, the QRZ.com Subscription is listed FIRST in the callsign lookup
sequence, and the callsign is located in the QRZ database, the DM-780 ALE will be
populated with the QRZ information and the fact that the station had been worked
previously and is in the Logbook, my be bypassed. This would then give the impression
that we had NOT worked that station at some point in the past.

The QRZ.com Subscription lookup feature is often referred to as the "QRZ XML "
lookup feature. An annual subscription fee is required to use this option. The
subscription is purchased directly from QRZ.com. There are many advantages to having
the QRZ XML subscription, but the main advantage is the database is NEVER out of
date and it contains both foreign and domestic callsigns. Options like the CDs can
become out dated also options like "Callook.info™ and "SAM CD" only support the
domestic USA callsigns.

With the added QRZ XML Lookup, HRD will now first check the logbook databases to
see if it can locate where you may have previously worked the entered call. If it does
NOT find the call in the Logbook databases, it will connect to QRZ.com, via the internet,
and locate the callsign in their on-line database. An XML file will be created and
downloaded with the information and the ALE will be populated with this information.

(28)



HRD Software LLC / HRD QUICK START

Once you have the additional Callsign
Lookup method selected in the enabled
side of the configuration window, don't
forget to click on the "Lookup Options" tab
at the top of the window and make sure
you have the correct configuration setup in
there. In our example for the QRZ.com
Subscription, you need to fill in the
information as indicated in the image on

®t: BUCK com Subscriptions

Remember to enable the

method yg:a%‘li':fé;;fe onthe  Emeracalisgn esuts are shown i popep windaw the Ieft
cuce Once you have his completed, click
"APPLY" and OK and your setup is
complete.

NOTE: If by some chance all the information is not populated in the ALE,
there is avery good reason. The majority of the information QRZ has on
file for each callsign is "user supplied”. Ifauser does NOT provide his grid
locator on his QRZ page, it will NOT be populated in the ALE. HRD can
ONLY download the information that is provided by the USER so we can't
guarantee the accuracy of the imported data.
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Clicking on the et on the Logbook toolbar opens the Add Log Entry panel.
"ADD" icon This is where we enter data about our contacts into the
Logbook.

il Adct KBINRH SO Log =] &

Date:

Fsical: ||

080 date Time on Call Mode Sent Revd Band Name Coun try

The ALE (Add Log Entry) panel is the
interface between you and your logbook.
Data in the ALE can be entered either
manually or automatically if you have a
callsign lookup option configured.

There are two major areas tothe ALE. The
upper half of the display is where the
current information is gathered and input
about the contact you are working. This
information can be entered manually from
the keyboard or, if you have one of the
callsign lookup options configured, can be
entered automatically when you enter the
callsign.

The lower portion of the ALE contains tabs where you can view a large amount of
information about your contact. It will show each time you have previously worked the
contact in your logbook, his location and even his mailing address, if available through
the callsign lookup option you have selected. It also has tabs to indicate how to QSL the
contact and how you have QSLed in the past.

The ALE alone can provide a multitude of information about your contact when used
with other available options in the logbook. You can find more information about the

ALE in the HRD User's Manual.
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Database Backup - Restore

The HRD logbook has your best interest in mind with it's built-in multiple backup utility. Several
backups can be made at one time either automatically or manually with just a couple mouse
clicks. The default location for these backups are in the C:\Users\<User
Name>\AppData\Roaming\HRDLLC\HRD Logbook\ folder. These locations can be changed
according to the user's preference. Backups can be saved on the local hard drive, on an
external drive or flash drive and even in the cloud such as in OneDrive or Dropbox, the last two
being the safest and most accessible should a problem occur where you need to restore your
database from a backup.

HRD creates an XML file for the full database backup. There are 3 ways you can store your
backups available in the Backup Options.

1. Single file backup in XML format

2. Single file back in XML format that is compressed into a ZIP file to conserve hard drive
space.

3. Multiple XML backup files added to a single ZIP file to further conserve hard drive space.

To access the HRD Backup options from the Main Menu, click on "Logbook > File >
Backups > Options" or you could also right-click anywhere on the Logbook Grid (area
showing contacts) and follow the above paths in the context menu.

e e backup options pancl, you

can configure WHERE you want
each backup type made as well as

Options for Automatic Database Backups Setting up WH EN you Want an
a’ﬁn automatic backup made.
re}

. Automatic Backups
|

-]

Save file in folder: G:\HRD Logbook Backups\XML Backups

]

1. Acheck mark in this box
M activates the single file XML

Archiv

[#]Compress to folder:  |C\Users\KB3NPH\AppDats\R. \HRD Logbook) C baCkup

x . - -

v 2. Clicking on this box allows
A

you to navigate to the

[1compress to folder:

| [“1Add to archive G:\HRD Logbook Backu...\LogbookBackups.zip 1_@ Ei |Ocat|0n for the XML backup
- ¢ 3. Activates the Single ZIP file
| backup
i 4. Allows navigation to where
+ | Bonclosing you would like these ZIP files
i [JEvery 10 hange stored.
MEvery |6 hours e 5. Activates the Multiple XML
Zip option.

6. Allows navigation to where
you want this ZIP file stored.
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7. The options in this box
allows you to configure
WHEN you would like the
automatic backups to occure.
In the example shown, a
backup is created each time
the Logbook is closed and
after every 6 hours of
continuous operation.

The automatic backup at closing will be made ONLY if there has been changes to the
database. For example, if you have added a contact to the logbook or edited a
current contact

already logged.

Once these options have been set, you can also do a manual backup at any time you
choose. Just right-click on the Logbook grid and select "File > Backups >
Backup" and the backups

configured will be created.

Restoring A Backup

Restoring your logbook from a backup can only be performed to an EMPTY database.
That means you can only restore a backup copy of your logbook to a database that has
NO contacts listed.

The restore function will only restore a backup that has been properly done into an XML
file. If you are using any of the ZIP storage options, you will need to unzip the file and
copy the most current XML file to a location, such as your desktop, prior to attempting a
restore.
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Restore
Loads the contents of the selected file (XML data) to the current database, this
file is created using the Backup option.

Error messages
Any errors are shown in the logfile, selected from the main View menu.

File Format
The file contains XML data, the attribute names are the same as the column

names in the database table. The format is for internal use by this program, it is
not designed for use with other software.

Backup File

GAHRD Loghook Backupsi=hL . AKB3NFH S0L Log backup 2076-01-30 0435xml

29

Restore Cancel

To restore your backup to the
database, just click "Logbook >
File > Backups > Restore" from the
main menu or use the context
menu by right-clicking anywhere
on the EMPTY logbook grid and
follow the menu to the Restore
function as above.

1. Navigate to the location where the
backup is stored and select a
recent backup.

2. Click the "Restore" button and
follow the instructions to restore
your backup.

Once the restore is completed, click
the "Finish™ button to return to the
logbook screen.

Please visit our YouTube channel and view the video at the link below. The video
demonstrates what we have covered in this section.

HRD Logbook Backup - Recovery: https://www.youtube.com/watch?v=Py4vvjlbRZk
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Digital Master-780

DM-780 Overview

DM-780 is a very sophisticated, feature packed, program that allows you to send and
receive many of the popular amateur radio digital modes, including SSTV, using a
computer soundcard. It supports AFSK modes as well as FSK RTTY.

The program integrates with the HRD rig control program to control band and
frequency changes without exiting the program. It's also integrates with the HRD
Logbook to allow easy callsign look-ups and logging of your digital contacts through its
built-in Add Log Entry (ALE) screen.

DM-780 has features not found in any other program on the market today. The
SuperSweeper gives you the ability to view and decode multiple signals using CW, BPSK
and RTTY in single window. You can also enable the SuperSweeper History file to keep
track of and display information about callsigns you have heard from your location.

The SSTV module has a built-in editor for creating templates for your outgoing
messages on background pictures from your own photo collections. It can also place an
incoming picture within one of your outgoing pictures so your contact can see just
exactly how his transmission looked when you received it. These are just a few of the
many great features of DM-780.

Audio Interfacing

DM-780 requires the use of an interface of some type to connect the soundcard to the radio.
Although the computers built-in soundcard can be used it is recommended you install a second
soundcard. The second soundcard can be either internal or external. The advantage of
having the second soundcard it can be used for your digital communications while eliminating
the possibility of transmitting unwanted computer sounds. You would also be able to listen to
music on your computer while still operating in the digital modes.

Next we need to interface the soundcard to the radio. Interfacing can be done in so many
ways that it would take days to plough through all the available information. You cando a
Google search and find hundreds of articles on the subject. It is possible to connect your radio
directly to your soundcard without any form of isolation but it is not recommended.  We'll
assume that you want to do things properly, so here is a homebrew circuit that has proved its
worth many times. It will work with any Icom or Yaesu rig that has a 6-pin mini-DIN
connector for external audio. It will work on just about any other rig but you will have to
modify the connections to your radio. If you plan to use the circuit below, please check the
actual connections to the mini-DIN — HRD Software LLC does not accept responsibility for
damage to your rig should things go wrong.
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P 'I 10yF %n‘rqlum
'3.5mm Stereo plug

T3 Sound Card "LINE OUT" ;‘ }
ot o) c1
T
2 \J pC GmundU 11 ]
P2 35mm Stereo plug Shield Radio Ground/Shield /5

"RING" Not used

K'"DTR" ine 5 to be
g the PTT driver. then '-E)E"‘

use pin 4

OPTOCOUPLER

— B ©TR optioray P "

p3 PC Ground

Rear P anel View
PC Ground =

& pin Mini DIN

Radio Ground

35 mm Stereo plug

TIP Sound Card "LINE IN® .
A ~ Rx Audio

o | N
L P1 P Shield  PC Ground =
RING" Not used L =PC ground

Transformers are 1:1 600 Ohm

Radio Ground/Shield
available from Radio Shack

A proven audio interface: cheap and easy to build

You should always use the rig's high-impedance audio output if there is one available: this
supplies a constant signal level to the soundcard. Most rigs also have a TX audio connector
independent to the microphone input: you are advised to use this input. Some commercial
interfaces don't allow this: It is recommended that you avoid any interface requiring use of
the microphone connector and speaker output unless there is no other option for getting the
audio signals to and from the radio.

There are also some very nice commercial solutions available for interfacing the radio's audio to
the computer. Tigertronics provides two such interfaces. One has a built-in soundcard and
one does not. The advantage of having an interface with a built-in soundcard is it frees up the
computer's internal soundcard for computer audio, such as listening to CDs, while using the
external soundcard for the digital modes.

SignalLink Model SL-1+

The SL-1+ connects to your computer's sound card and to your radio's Mic, Data or Accy Port. It is
designed to work with ALL computer sound cards, and with ALL radios. The SignaLink SL-1+ is compact,
low powered and fully isolated for optimum performance. It supports ALL sound card Digital and Voice
modes, and does NOT use a serial or USB port!
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SignaLink USB

The SignalLink™ USB combines the legendary performance of the SignaLink SL-1+ with a state of the art
"built-in" low-noise soundcard. The SignalLink USB has only one USB connection to the computer, and in
most cases, only one connection to the radio. Convenient front panel controls make setup and
operation very easy. The SignalLink USB is fully isolated and is compatible with ALL radio Mic, Data, and
Accessory Ports, and supports virtually ALL sound card Digital and Voice modes. Both of the above
interfaces are available from on the Tigertronics website at http://www.tigertronics.com

Another commercial solution to interfacing the radio's audio to the computer is the Navigator.

The Navigator

The Navigator interface is available on the web from U.S. Interface Products. The website is at

http://www.navigator-interface.com/naviusa 004.htm  The Navigator is a high quality interface

between the rig and the computer, for use in running the digital modes such as PSK31, Olivia, MFSK,
Hellschreiber, MT-63, etc. It also works fine for SSTV..

The Navigator interfaces to the rig using a USB port, thus it does not require a serial port on the
computer. The Navigator has a built-in soundcard for audio from the radio to the computer. It also
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provides CAT control to the rig via a serial connection from the Navigator to the rig. The Navigator is
completely configured and defined in software, and future updates are expected to be flash-ROM updates
that can be installed by the user.

The Navigator is also directly supported by DM-780 by clicking on Program Options and then selecting
Navigator from the list of options on the left side of the window.

ey RETLE 0

micro Keyer Il

micro KEYER 1I™ is the most powerful single radio All-In-One USB interface and the only USB
interface to fully support voice operation including microphone switching. With an single USB
port, micro KEYER II™ works with any Windows-based logging or control program for CW, voice,
FSK and digital (RTTY, PSK31, SSTV, OLIVIA, MFSK, WSIT, etc.) operation. micro KEYER II™
includes a radio control interface that supports all standards (RS-232, ClI-V, Kenwood and Yaesu
TTL), a powerful CW memory keyer using K1EL's WinKey, a Digital Voice Keyer, two channel
audio for transceivers with dual receivers, automatic microphone selection, and a

buffer/sequencer for amplifier or LNA control. micro Keyer Il is available from the MicroHam
website at  http://www.microham.com

Other companies who provide audio interfacing solutions that work well with HRD are:

TimeWave: http://www.timewave.com

ZLP Electronics: http://www.g4zlp.co.uk

West Mountain Radio (RigBlaster): http://www.westmountainradio.com

Rig Expert: http://www.rigexpert.com/index?s=standard

BuxComm (Rascal):
http://www.packetradio.com/catalog/index.php?main page=index&cPath=2

If you choose to use one of the commercial audio interfaces, make certain you follow the
manufacturer's instructions carefully for installation and set up.
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Configuring DM Radio Pane

File Edit View QSO Browser Logbook 551

2 &
QSO SuperSweeper

Locator

- 0 x

-850
u « » | 4 - »
-

14.235.000

- Mode: USB -

AGC: Medium
- CW Keying ¥ W Pitch: 800 Hz

- Mode Key

T=

Soundcard | Callsign Looku;‘:»\\FT-BSDJ

Connect to HRD User Interface

=
Radi card Data Cor
13

An important step in setting up DM780 is the configuration of
‘the Radio Pane. On the DM780 top menu click on VIEW > then
click on RADIO or click on the "RADIO" icon as indicated #1 in
the image on the left. The following Radio Pane will appear on
your display on the left of the Digital Master main screen.
‘Here is where you can configure various function buttons and
sliders to control your radio directly from the Digital Master
screen.

Right now, we're interested only in configuring your "TX"
button for your radio. To do this, click on the "Configure"
icon, indicated by the #2 in our illustration. This will open the
Configuration screen.

-In the image on the left you will first see the HRD User
interface information. Be certain it shows an "Address" of
"localhost" and a port of "7809" Be certain there is a check
mark in the box to automatically connect, then click on the
"Connect" button.

There MUST be at least a "TX" button configured in order
for DM780 to key your radio from within the digital
.. modes.

- 1. Left click on the button indicated

2. The Select Button screen opens

3. Locate and left click on the "TX" command
4. Click the "OK" button

5. Click "Save"

The TX button is now configured.
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From the menu bar select TOOLS then from the drop-down box select Program

Options.

soundcard configuration screen will open.
pictured below, don't worry, the difference is covered in our HRD Users Manual.

From the left side of the Program Options select Soundcard. The
If yours does not look exactly like the one

Just

be sure you follow the instructions to select the proper soundcard.

Program Options

Appearance
Callsign (My Info)
Clock

Logbock

Modes + IDs

PTT

Radio

Qso

Soundcard
Sounds

Storage
SuperSweeper
Waterfall

Alarms...
Favorites..
Macros...
Medes...
Navigator...

Audio Recorder...
PSK Reporter...

[©@  Getting Started

Soundcard Calibration...
Time Synchronisation...

Soundcard

Input (Receive)

Device: [Microphone {4- USB Audio CODEC -]

(High Defintion Audio Device
Line 1 (Vitual Audio Cable]

Source:

Output (Transmit)

Use input device

Device: [Speakers'- USB Audio CODEC ) -

Source (eed

Output (Transmit)

0dB 25dB 5dB @ 10dB 15dB 20dB

| Show sample rate in main status bar

For recording and playback of wave files see: Recording

You can see the Input (Receive) device at
the top of the options. There is a drop-
down box where you select the input device
on the soundcard that receives the audio
from the radio. In this illustration we are
using the Microphone input from our USB
Audio CODEC, which is our SignaLink
external soundcard.

For the Output (Transmit) device,
another drop-down box where you select to
send the audio from the soundcard to the
radio. In this case, the Speakers of our
USB Audio CODEC is selected.

If your audio interface uses the computer's
internal soundcard, you would select that in
the configuration windows.

If we are using an external soundcard, such as the SignaLink, we need to make certain

our computer doesn't use it as the default device for normal computer sounds.

Todo

this, you will need to open your Control Panel, and select the "Sound™ utility.
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On the "Playback" tab of the Windows soundcard

utility, if you are using an external soundcard,

make certain you select the normal internal
m Sbete i lod sound device as the default device for the

computer sounds. If you select your external

device as default any time the computer makes
any type of sound, that sound could be
transmitted over the air along with your digital
signals.

Flayback Recording Sounds Communications

Select a playback device below to modify its settings:

[ - Digital Display A
-

Vs .{:' {P02 Stereo
B Speakers /

h. Speakers (PK2325C) s
11En Aedin mODCe

o

O

o
i

Caonfigure

oK Cancel Apply

PTT Configuration

The final item for configuration of the soundcard is setting the PTT option.

_Select Program Options by either clicking
oo o on the toolbar icon or click on "Tools >
Program Options”. Once this window
opens, you can configure the PTT option.
This option will differ in different setups
depending on the soundcard used or the
hardware interface you are using.

Normally, if you are using a SignaLink
interface, the PTT should be set to "None
-via soundcard PTT or radio vox".

®  Getting Staned

In general, when using other hardware
interfaces you can select "Ham Radio
Deluxe - via Ham Radio Deluxe - DM-780
must be connected to HRD". What this
means is you must have the HRD Rig
Control module running in order to key
the transmitter.
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Other hardware interfaces have a designated com port for keying the PTT line.
Documentation for the interface you are using should tell you how to configure the PTT.

It's very important that you read your interface manual and your radio's owner's
manual. Both will tell you exactly what has to be done with the equipment and how to
set up the PTT, soundcard, etc. As we say "RTFM", "Read The FINE Manual”. 1n 99%
of the cases, "Common Sense", your "Radio User's Manual" and the "HRD User's
Manual" will tell you everything you need to know to setup HRD to operate with your
radio. As mentioned earlier in this document, even though the HRD V6.2 manual may
be a little outdated the basic functionality has NOT changed from HRD Version 5.x to
the current version. We may have added a few new features but the BASICS are still
the same.

Select A Mode

|1 DM780 there are several ways to
select the digital operating mode.
The images on the left show two of the
available ways to select the mode.

BPSK-31-| W 2 0. O 5 | (E
ow
RITY
PSK ’ BPSER31
1
QPsK v BPSKTE3
CONTESTIA » BPSK-125
T r CODEC
DominaEx

rooee  #1. There is a tab on the Receive Pane

w o L. toolbar which indicates the current
o mode selected in DM-780. Left
THOR clicking on this tab opens a dropdown
«» - menu showing the MAIN modes.
S T | TR ~= «:\When you select one of the "Main"

modes of operation, a second
dropdown will open allowing you to
select the variation of the Main mode
ammyOU Would like to use. The example
= shows the PSK mode selected, and the
sub menu shows the actual variation
of the mode you want to use.

#2. The second option available to
select the mode is by left-clicking
anywhere in the "waterfall" area and
a scrollable menu will open allowing
you to select the mode.
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—+#3. The third option available to select the mode is from

1 |Modes G BF . . .. . .
f ~ ~/| aTABwhich is visible on the main DM-780 display.
= This "Modes" pane has the modes divided into
cw - .
A #3 collapsible/expandable blocks for each Main mode.
CW (WinKey) When expanded the block contains all the variations of
CW (SSB) the Main mode from which to choose.
RTTY £
RTTY-45 (AFSK)
RTTY-45 (FSK)
RITY-50
RTTY-75
PSK &
4
BPSK-31
BPSK-63 H
BPSK-125 e
o}
QPsK ¥
CONTESTIA ¥
| DominoFx _ ¥ ¥
FT-857 | Tags. wj!uu'll need to dgw_r!_lg_a_qt.;_ Ente
The Waterfall

The Waterfall in the DM-780 main display is the way we tune our signals for receiving
and transmitting.

Why are there two frequency scales available on the waterfall?

We are not going into any details for the reason there are two scales available on the
waterfall in this document. There is more detail in the HRD DM-780 User's Manual,
however, if you would like to find more information on the internet, the PODXS 070
Digital Radio Club has a great website which has many helpful files about operating in
the digital modes. You can also click on, or copy and paste the following link into your
favorite Web Browser to access the HRD Knowledge Base information on this topic.

http://tickets.hrdsoftwarellc.com/kb/fag.php?id=44

Below are the options used to display the two different frequency scales on the
Waterfall.
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Frequency On the Waterfall toolbar, clicking on
[“] Show RF frequency (radio + audio. requires a radio connection) "Optionsu Opens the Prog ram Options for the
Llsadelesi @+ O [ ] ' Waterfall. Selecting the "Frequency, Mode,

Speed" tab and looking near the bottom of
that pane you will see the setting for
displaying either the "RF Frequency" scale
on the waterfall or the "Audio” frequency
scale. Placing a check mark in the box as
shown in the illustration on the left selects
the RF Frequency scale.

Waterfall

ESN HRD Logbookc Not Connected RSID

Audio Offset Frequse.ncy Scale

Main Tuning Marker

ym aom 40m 20m : 1 NE IMage on the left is the "Main Tuning Marker" located on the DM-780
\Waterfall. This marker is your "Cursor” and is used for tuning the individual
rallmaed L aces for the signals you see in the waterfall's passband. The letter "M" in

Il the gold square above the frequency indicates "Main". There is a "dotted"
line extending downward from that "M" to the center of the horizontal gold
bar, just below the frequency scale. This horizontal gold bar, indicates the
bandwidth of the signal, in the case of the one shown here, a PSK signal that
Is 31.5 Hz side. The width of this horizontal gold bar varies depending on the
bandwidth mode's signal you have selected. The two thin lines extending
downward from each end of the bandwidth indicator aid in centering the
tuning marker on the received signal, as you will see in the next illustration.
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To properly tune a digital signal, move your cursor along the waterfall until
the "M" marker is positioned on the CENTER of the a signal as shown in the
;image on the left. This properly adjusts the "audio” frequency of in HRD to
properly decode the received signal and to encode the transmitted signal
using the proper audio frequencies. With your cursor and Main Marker set
this way on the waterfall, you should now see text being decoded and
displayed in the Receive Pane of DM-780.

I  i650m s0m 4

Transmitting In Digital Modes

Now that you are receiving digital signals, transmission is very simple. Again, use the
"M™ marker (cursor) to select the "audio™ frequency on the waterfall where you want to
transmit. Once that is positioned, click on one of the CQ macros or type your CQ into
the Transmit Pane of DM-780 and click the "Send (F4)" or the "Auto (F2) button to
transmit the text.

At this point check to make sure you have RF out on your watt meter. If your radio
keys but you don't have any RF output, you need to check your soundcard settings to
make sure they are correct according to your interface manual. If everything appears
correct there, you need to check your radio's menus to make certain things are set
correctly there.

Some radio's need to be manually set to "DATA", "DATA - U" or "DATA - L" in order to
accept the input audio from the computer. In other radios, you need to look for menu
options like "Data On Mod", Data Off Mod", and any settings that pertain to the way you
have your radio interfaced to the computer. This is important especially if you have
one of the newer radios that have two or more ways of interfacing, like some of the Ilcom
radios use a CI-V port, which is usually just a 3.5mm phone jack connection to the
computer. If this is how you are interfaced, you will need some sort of audio interface
along with the rig control connection. If the radio uses the USB for Rig Control and the
audio interface, there are settings in the radio's menus which need to be set to indicate
the USB port is used for the Digital Signals.

Other radios, using just the USB require menu settings which route the audio and rig
control through the USB port on the back of the radio rather than from the CI-V port or
RS-232 port. Knowing your radio is important here, and reading your radio's manual
is a must if you want to get things up and running.

You can always check our Knowledge Base for help. We have PDF files in the
Knowledge Base with full instructions for setting up some of the more popular radios.
If you can't find help there, your always welcome to contact the support team for
assistance.
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